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City of Fort Lauderdale 
How to Create a Heat Map  
for Energy Usage
March 2019

Purpose: 

The City of Fort Lauderdale uses heat maps to visualize hourly energy usage. This allows the City to identify opportunities 
for savings and evaluate the impacts of efficiency measures.  The instructions below detail how the City of Fort 
Lauderdale creates its heat maps. The steps below describe how City of Fort Lauderdale staff extract hourly data from 
the Florida Power and Light (FPL) website and then create a heat map in Microsoft Excel with that data.  Most, but not all 
FPL, accounts will allow access to hourly data. If FPL is not your utility but you can obtain hourly energy usage data, you 
can still create heat maps by starting at “To Sort and Organize Data in Excel” on page 2.

For more information on how to use and interpret heat maps, please see pages 4 and 5.

To Access Account Information in the FPL Portal:

Log on to FPL website using login credentials here: https://www.fpl.com/my-account/account-landing.html#list.
If the desired account is listed in the FPL online portal, skip to the next step. If the account is not already added to your 
online view, follow the instructions on the FPL site to do so and then continue with the steps below. 
Use the search boxes to search for the desired account. 

o	 Search by: Account Number or Address

o	 Enter Keyword: Enter account number or address

1)	 Press Search.

2)	 Click on the account name that comes up in the search. 

3)	 Click the blue lettering in the first column (“Name”) of the row containing the account you want to select. 

To Access Hourly Energy Data in the FPL website:

1)	 Scroll down and click on the link that says Visit Energy Dashboard (to the right of Energy Usage and above the 
usage graphics). 

o	 A notice might come up regarding bill projection and entitled “Important Note About My Energy Usage”, 
close this notice and view the Chart. 

2)	 On the top right of the bar chart graph, click on Hour for accessing hourly data (another pop up notice may 
appear). 

o	 FPL keeps approximately 3 months on most accounts—if an ongoing record without gaps is required, a 
download schedule should be established (e.g., once every two weeks or once a month).

3)	 Click on Download and select .xls format.

https://www.fpl.com/my-account/account-landing.html#list
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To Sort and Organize Data in Excel:

1) Open the downloaded data in Microsoft Excel.

2) Verify data is complete and hourly.

3) Select all data in the spreadsheet except titles. (Figure 1)

 Figure 1

4) Under the Data tab, click Sort. First, select the Sort By dropdown menu and click Date, then click the Add Level 
button in the upper left. A new drop down menu will appear—in the Then By drop down select Hour. In the Hour 
row in the Order column, select Custom List and create a list that follows the chronology of a day—12:00AM, 
1:00AM, 2:00AM, etc. (this will appear as a drop down option for future heat maps). Click OK on the Sort popup 
box.

5) A pop-up box entitled Sort Warning will appear—click on the first button, Sort anything that looks like a number, 
as a number. Click OK.

o If the data spans two years, the sorting results should be checked to ensure that years are not sorted 
incorrectly.

6) Select spreadsheet cells containing data in the Date, Hour and Consumption Recorded columns, including the 
headers. (Figure 2) 

 Figure 2
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7)	 Under the Insert tab, click Pivot Table, then click OK.

8)	 On the right side of the worksheet a Pivot Table Field List box will appear.  In the box at the top of the right panel, 
choose the Date, Hour, and Consumption Recorded as fields to add to report. In the four boxes at the bottom of 
the right panel, drag the word Date in the top box to the Row Labels box below, Hour to the Column Labels box 
and Consumption Recorded to the Values box. (Figure 3). 

o	 If Consumption Recorded comes up as ‘1’, click the arrow in the Value box, then click Value Field Settings, 
click Sum and then press OK. The original values should populate the sheet. 

   
Figure 3

To Create a Heat Map:

1)	 Select all consumption data that you want color coded. Do not include the Grand Total row or Grand Total 
column. (Figure 4)

Figure 4
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2)	 Under the Home tab, click on Conditional Formatting and move mouse to Color Scales. Select “Red-Yellow-Green” 
color scale. 

o	 To manually select a different color scheme, see below (colors choices can be changed as desired):

-	 Click More Rules…

-	 Select Format Style as 3-Color Scale or click 2nd Red Map

-	 Under Minimum, choose color Green.

-	 Under Midpoint, choose color Yellow. (The percentile may be the best visually when set 
somewhere between 45-70, depending on the account usage.) 

-	 Under Maximum, choose color Red.

-	 Click OK.

3)	 The conditional formatting can be applied to the Grand Total row or column separately if desired. However, 
conditionally formatting the hourly and total columns in one step will produce undesirable results (total columns 
will be more red and hourly columns will be greener than desired).

4)	 Add title, unit of energy, and other explanatory information for the map as desired. (Figure 5)

Figure 5

5)	 Add events column if necessary. (e.g., closures, dates of 
upgrades, or other events which would impact energy 
consumption). 

6)	 Add legend. (Figure 6)

Weather Data (Optional):

1)	 If weather information is desired, add columns for weather 
data (e.g., average, high temperature, low temperature, and 
precipitation). 

2)	 Information can be found here: https://www.ncdc.noaa.gov/cdo-
web/search

3)	 To search for daily temperature and precipitation, select Daily 
Summaries as the Weather Observation Type/Dataset, choose 
a Date Range, search for Cities and type the name of the 
appropriate city (e.g., Fort Lauderdale). 

4)	 After clicking search, a list of possible locations will appear- 
select the appropriate city name and click ADD TO CART.  This 
option will include all of the stations associated with the City, to 
narrow the results, see below.

Location max/min temperature data is from NOAA's climate data online resource https://www.ncdc.noaa.gov/cdo-web/         
Energy data is from FPL https://www.fpl.com/         

Date Weekday
 Total Daily 

Consumption 
(Unit: kWh)

12:00AM 1:00AM 2:00AM 3:00AM 4:00AM 5:00AM 6:00AM 7:00AM 8:00AM 9:00AM 10:00AM 11:00AM 12:00PM 1:00PM 2:00PM 3:00PM 4:00PM 5:00PM 6:00PM 7:00PM 8:00PM 9:00PM 10:00PM 11:00PM
01/23/2017 Mon. 30 30 30 30 30 30 30 21 15 15 15 14 15 14 15 14 15 16 30 30 30 31 30 530
01/24/2017 Tue. 30 30 30 30 30 30 31 30 19 15 15 14 14 15 15 15 14 15 17 32 32 31 34 33 570
01/25/2017 Wed. 31 30 30 30 30 30 30 30 20 14 15 14 14 15 15 14 14 15 15 30 30 30 30 30 560
01/26/2017 Thu. 30 30 29 30 30 30 29 30 19 15 15 14 14 15 14 14 14 15 16 31 31 32 31 32 562
01/27/2017 Fri. 31 30 30 30 30 30 30 30 19 15 15 14 14 14 15 14 15 14 17 31 32 31 34 34 570
01/28/2017 Sat. 32 32 31 31 31 31 31 30 20 15 15 15 16 15 15 16 16 15 15 31 31 31 32 33 578
01/29/2017 Sun. 31 30 31 31 30 30 30 30 30 22 14 15 14 15 15 15 15 16 23 30 30 30 30 30 587
01/30/2017 Mon. 30 30 30 30 30 30 30 30 17 15 15 14 15 14 15 14 14 15 16 30 31 31 31 32 558
01/31/2017 Tue. 31 30 30 30 30 30 30 30 19 15 14 14 14 15 15 15 14 15 15 30 31 30 32 32 559
02/01/2017 Wed. 31 30 30 30 30 30 30 30 19 15 15 14 15 15 15 14 14 15 15 31 30 30 30 31 558
02/02/2017 Thu. 30 30 30 30 30 30 30 30 22 15 15 15 15 15 15 15 15 15 15 30 32 32 31 33 569
02/03/2017 Fri. 33 31 31 30 30 30 30 30 21 15 15 15 14 15 15 15 15 15 15 30 31 30 30 31 566
02/04/2017 Sat. 30 30 30 30 31 32 30 30 18 14 14 14 14 15 15 15 15 15 16 30 32 31 31 33 567
02/05/2017 Sun. 32 31 30 30 30 30 30 30 20 15 15 16 18 19 19 20 19 19 18 29 31 31 30 30 591
02/06/2017 Mon. 30 30 30 30 30 30 30 30 18 15 15 15 15 15 15 15 15 15 15 29 30 31 31 30 561
02/07/2017 Tue. 30 30 30 30 30 30 30 30 18 15 15 15 15 16 16 16 15 16 16 30 32 31 32 31 569
02/08/2017 Wed. 31 31 31 31 31 31 31 30 16 16 16 15 15 16 16 15 16 16 16 29 31 31 31 31 571
02/09/2017 Thu. 31 31 31 31 31 31 31 31 22 15 15 16 15 16 15 15 15 16 18 31 32 31 31 32 582
02/10/2017 Fri. 31 31 31 31 31 31 31 31 18 15 15 15 15 15 15 15 15 15 15 28 30 30 30 30 565
02/11/2017 Sat. 30 30 30 31 31 30 30 30 18 15 15 16 15 15 15 15 15 15 15 29 31 32 32 33 570
02/12/2017 Sun. 32 31 30 30 30 30 30 30 18 15 15 15 14 15 16 15 15 17 16 28 31 31 30 30 564
02/13/2017 Mon. 30 30 30 30 30 30 30 30 17 15 15 15 15 15 15 15 15 14 16 30 32 31 31 30 558
02/14/2017 Tue. 30 30 30 30 30 30 30 30 16 15 15 15 15 15 15 15 15 15 16 29 31 32 32 32 564
02/15/2017 Wed. 31 30 30 30 30 30 30 30 16 15 15 15 15 15 15 15 15 15 16 29 32 32 32 33 569
02/16/2017 Thu. 32 31 31 30 30 30 30 30 21 15 15 15 15 15 16 15 15 15 16 30 34 31 32 33 576
02/17/2017 Fri. 32 31 30 30 30 30 30 30 17 15 15 15 15 15 15 15 15 15 15 28 33 31 33 35 571
02/18/2017 Sat. 33 31 31 31 31 31 31 30 16 15 15 15 16 16 16 16 16 17 16 30 34 32 32 34 585
02/19/2017 Sun. 34 32 31 31 31 33 35 34 17 18 20 20 19 18 17 17 16 17 17 28 32 31 33 31 609
02/20/2017 Mon. 30 30 30 30 31 30 30 31 17 15 15 15 15 15 15 15 15 15 15 27 31 30 31 30 559
02/21/2017 Tue. 30 30 31 30 31 30 30 30 17 15 15 15 15 16 15 15 15 15 16 31 31 30 31 31 567
02/22/2017 Wed. 30 30 31 31 31 30 30 30 26 16 15 15 16 16 16 16 16 16 16 27 31 31 32 32 579
02/23/2017 Thu. 31 30 31 30 30 31 30 30 17 15 16 15 15 15 16 15 15 15 16 27 31 31 32 32 565
02/24/2017 Fri. 30 30 31 31 31 31 30 30 17 15 15 15 16 15 15 14 15 15 16 27 31 31 32 33 565
02/25/2017 Sat. 31 31 31 31 30 30 30 30 16 14 15 16 16 16 17 18 17 19 18 28 32 31 31 34 582
02/26/2017 Sun. 30 31 32 30 31 30 30 30 15 15 15 15 15 18 16 16 18 18 18 27 31 31 31 31 575
02/27/2017 Mon. 31 31 31 30 30 30 30 29 15 15 15 15 14 15 15 15 15 14 15 27 30 30 30 30 550
02/28/2017 Tue. 30 30 30 30 30 30 30 29 15 15 15 15 15 15 15 15 15 15 17 27 33 31 30 31 555
03/01/2017 Wed. 30 30 30 30 30 30 30 28 15 14 15 15 15 15 15 15 14 15 16 27 32 31 30 31 554
03/02/2017 Thu. 30 30 30 30 30 30 30 29 15 15 15 15 15 15 15 15 15 15 16 27 32 32 33 32 562
03/03/2017 Fri. 32 31 30 31 31 30 30 28 14 15 15 15 15 15 16 15 15 15 16 26 32 31 32 33 563
03/04/2017 Sat. 32 32 31 31 30 30 30 29 14 15 15 15 15 16 18 17 16 18 18 27 31 31 31 35 575
03/05/2017 Sun. 31 30 31 31 30 30 30 26 15 14 15 15 19 19 18 20 21 18 16 31 31 33 35 31 590
03/06/2017 Mon. 31 31 30 30 30 30 30 28 15 15 15 15 14 15 15 15 15 15 16 25 30 31 30 30 550
03/07/2017 Tue. 30 30 30 30 30 30 30 28 14 15 15 15 15 15 15 15 15 15 15 26 32 31 32 33 556
03/08/2017 Wed. 32 30 30 30 30 30 30 25 15 16 15 15 15 15 15 15 15 15 15 25 31 30 30 30 549
03/09/2017 Thu. 30 30 30 30 30 30 29 27 15 15 15 15 15 15 15 15 15 15 16 25 33 32 31 35 555
03/10/2017 Fri. 31 30 30 30 31 30 30 27 15 15 15 14 14 15 15 15 15 15 15 25 31 31 30 31 550
03/11/2017 Sat. 30 30 31 30 30 30 30 28 15 15 15 15 15 16 16 17 16 17 18 25 32 32 32 32 568
03/12/2017 Sun. 30 31 34 33 33 30 30 30 20 15 15 16 16 17 18 17 19 18 16 30 30 30 30 557
03/13/2017 Mon. 30 30 30 30 30 30 29 30 27 15 15 14 15 14 15 15 15 15 16 16 25 31 30 30 545
03/14/2017 Tue. 30 30 29 29 29 29 29 29 24 15 15 14 14 15 15 15 15 15 15 16 24 30 30 31 536
03/15/2017 Wed. 30 30 30 30 29 29 29 29 24 16 16 15 15 15 15 15 15 15 15 15 23 30 30 30 538
03/16/2017 Thu. 31 29 30 30 30 29 29 29 26 15 15 15 14 15 15 15 15 15 16 15 23 30 31 31 542
03/17/2017 Fri. 30 30 29 30 30 30 30 29 24 15 15 15 15 14 15 15 15 15 16 15 23 30 30 31 541
03/18/2017 Sat. 33 34 37 35 35 34 30 29 26 15 15 15 14 15 15 16 15 16 17 18 23 32 34 33 585
03/19/2017 Sun. 31 32 32 31 31 31 30 30 24 14 14 15 15 15 16 18 19 17 21 20 24 30 30 30 571
03/20/2017 Mon. 29 29 29 29 29 29 29 29 23 15 15 14 15 15 15 15 15 15 15 15 23 30 30 29 531
03/21/2017 Tue. 29 29 29 29 29 30 29 29 25 16 16 17 16 15 15 15 15 15 15 16 24 30 30 33 548
03/22/2017 Wed. 30 30 29 29 29 29 29 29 23 15 15 15 15 15 15 15 14 15 16 16 23 30 30 31 536
03/23/2017 Thu. 30 29 30 30 30 30 29 29 22 14 15 14 15 14 15 15 15 15 16 16 27 30 30 32 542
03/24/2017 Fri. 30 30 30 29 29 29 29 29 22 15 15 14 15 15 15 15 15 15 16 16 23 30 30 32 535
03/25/2017 Sat. 31 30 30 29 29 30 29 29 22 14 15 15 15 19 20 18 19 20 17 18 28 30 31 33 571
03/26/2017 Sun. 32 30 30 30 30 29 29 29 22 14 14 15 15 16 16 15 19 17 18 16 23 31 31 31 554
03/27/2017 Mon. 30 29 29 29 29 29 29 29 22 15 15 15 14 15 15 14 14 15 15 15 21 30 29 29 526
03/28/2017 Tue. 29 29 29 29 29 29 29 29 21 15 15 15 15 15 15 15 15 16 16 16 23 30 29 30 532
03/29/2017 Wed. 30 29 29 29 29 29 29 29 20 15 15 15 15 16 17 16 15 16 16 16 22 31 29 31 538
03/30/2017 Thu. 30 29 23 15 13 14 27 27 19 14 15 14 14 14 14 14 14 14 15 15 14 14 14 23 419
03/31/2017 Fri. 23 21 20 18 19 18 18 18 12 9 9 8 8 9 7 6 6 6 8 10 16 18 19 20 327
04/01/2017 Sat. 18 16 16 16 15 15 14 15 10 6 7 9 9 9 11 9 9 10 12 10 14 18 18 20 303
04/02/2017 Sun. 19 18 16 17 16 16 15 14 10 6 7 8 10 13 11 12 11 11 10 7 12 16 15 14 302
04/03/2017 Mon. 15 14 14 14 14 14 14 14 9 7 7 6 6 6 7 7 6 8 8 8 11 17 15 15 256
04/04/2017 Tue. 14 14 11 11 10 10 10 10 7 5 6 4 5 5 5 5 5 6 6 5 9 11 12 11 197
04/05/2017 Wed. 11 10 9 9 10 10 11 11 6 5 6 5 4 5 5 5 5 6 8 7 9 16 16 12 202
04/06/2017 Thu. 12 11 11 10 10 10 10 10 6 6 6 4 4 5 6 5 4 6 8 11 12 18 17 18 221
04/07/2017 Fri. 13 13 12 12 12 11 10 11 7 4 6 4 4 5 5 5 5 5 6 9 11 15 18 15 218
04/08/2017 Sat. 15 13 13 12 13 12 10 11 6 5 4 4 5 5 4 4 5 5 5 6 10 14 13 14 207
04/09/2017 Sun. 13 12 13 13 13 13 11 11 6 4 4 4 5 6 7 6 6 7 7 5 8 13 12 11 211
04/10/2017 Mon. 10 10 10 10 9 9 10 9 7 5 5 4 5 5 5 5 5 5 5 4 7 11 11 10 176
04/11/2017 Tue. 11 11 10 10 10 10 10 10 6 5 5 4 5 5 5 5 6 6 5 4 7 10 11 11 184
04/12/2017 Wed. 10 10 10 9 10 11 10 10 9 5 5 5 7 6 7 7 7 7 7 7 9 13 13 15 209
04/13/2017 Thu. 12 11 11 11 11 11 10 11 6 5 6 5 5 5 5 5 5 5 5 5 6 11 12 12 192
04/14/2017 Fri. 12 12 12 11 12 11 10 11 6 5 6 5 4 5 5 5 5 5 6 5 8 11 12 12 193
04/15/2017 Sat. 12 13 12 12 12 12 10 10 5 4 4 4 4 6 9 11 10 9 9 8 9 12 12 12 222
04/16/2017 Sun. 12 13 14 14 12 12 10 11 5 3 4 4 5 5 4 5 4 6 6 9 9 12 16 16 213
04/17/2017 Mon. 13 11 10 10 10 10 10 10 5 5 5 5 4 4 5 4 4 5 5 4 9 11 11 10 180
04/18/2017 Tue. 11 11 11 11 10 10 9 10 5 5 5 5 5 5 5 4 5 5 8 8 11 15 14 18 207
04/19/2017 Wed. 14 11 10 10 11 10 10 10 5 5 5 5 5 5 6 5 5 5 7 7 11 14 13 16 205
04/20/2017 Thu. 14 12 11 10 10 10 11 11 6 5 6 5 5 5 5 5 5 5 7 6 12 15 13 19 214
04/21/2017 Fri. 16 13 12 11 11 10 10 10 4 5 5 5 5 4 5 5 5 5 6 6 8 13 12 15 200
04/22/2017 Sat. 13 13 13 12 12 12 11 10 6 4 5 5 5 6 5 6 6 7 8 8 10 14 13 13 215
04/23/2017 Sun. 14 13 13 13 13 12 11 11 8 4 4 5 5 6 7 7 6 9 6 5 5 11 11 10 209
04/24/2017 Mon. 9 10 11 10 10 10 10 10 6 5 5 4 5 5 5 4 4 5 7 6 7 14 11 11 185
04/25/2017 Tue. 11 10 10 11 10 10 10 11 5 6 5 4 4 5 5 5 5 6 6 6 8 12 12 13 192
04/26/2017 Wed. 13 10 10 10 10 10 11 10 5 5 5 5 4 5 5 5 5 5 6 6 10 16 14 14 200
04/27/2017 Thu. 13 11 11 10 11 11 10 10 4 5 5 4 4 4 5 5 5 6 7 7 9 13 12 16 197
04/28/2017 Fri. 13 12 12 12 11 12 10 10 5 5 6 5 5 5 5 5 4 6 7 8 13 14 14 17 214
04/29/2017 Sat. 14 13 13 12 12 12 11 11 4 4 6 6 6 8 9 8 7 8 11 8 11 14 14 19 241
04/30/2017 Sun. 16 15 14 13 14 13 11 13 8 4 4 5 7 8 10 6 9 11 8 8 9 13 15 12 246
05/01/2017 Mon. 11 11 10 10 10 10 10 8 5 4 5 4 4 5 5 4 5 5 5 6 10 11 10 10 179
05/02/2017 Tue. 10 11 10 10 10 10 10 9 4 5 5 4 4 5 5 5 5 6 6 8 12 14 12 13 192
05/03/2017 Wed. 12 11 10 10 10 10 10 10 5 5 5 5 5 7 7 6 6 7 7 8 10 13 11 13 202
05/04/2017 Thu. 11 10 10 9 10 9 8 8 5 5 5 5 5 5 5 5 5 5 7 7 9 15 15 16 195
05/05/2017 Fri. 11 13 10 10 10 9 9 7 5 5 5 5 5 5 5 5 5 6 7 8 9 14 17 18 203
05/06/2017 Sat. 15 17 17 15 15 14 10 9 4 4 5 5 6 7 8 7 7 9 7 9 9 12 14 18 245
05/07/2017 Sun. 14 13 12 11 12 12 10 8 4 4 5 6 9 12 8 9 11 10 8 6 5 10 10 11 222
05/08/2017 Mon. 10 10 9 9 8 9 9 8 5 5 6 5 4 5 6 5 4 5 5 5 5 10 9 11 167
05/09/2017 Tue. 9 10 9 9 9 10 9 9 6 6 6 5 4 5 5 4 5 6 7 7 7 11 12 10 179
05/10/2017 Wed. 10 9 9 9 9 8 9 8 5 5 6 4 5 5 5 5 5 5 7 7 8 12 11 14 182
05/11/2017 Thu. 11 10 10 9 10 9 9 9 5 5 6 6 5 5 5 5 5 6 8 9 9 14 13 16 196
05/12/2017 Fri. 14 13 11 10 11 11 10 7 5 5 5 5 4 5 5 5 5 6 7 7 9 13 13 17 202
05/13/2017 Sat. 13 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 13
05/14/2017 Sun. 0 14 13 13 13 12 10 11 7 4 4 4 6 7 6 6 6 6 6 5 6 11 11 11 190
05/15/2017 Mon. 10 11 11 10 10 10 10 8 4 5 5 4 5 5 5 4 6 6 6 5 6 11 11 10 178
05/16/2017 Tue. 10 11 10 10 10 10 10 10 5 5 5 5 5 4 5 5 5 8 7 9 8 14 15 17 202
05/17/2017 Wed. 11 11 11 10 10 10 10 9 5 6 5 5 5 5 5 4 4 5 6 7 7 14 11 12 188
05/18/2017 Thu. 11 10 11 10 11 10 10 9 5 5 5 4 4 5 6 9 9 9 7 13 7 14 13 11 209
05/19/2017 Fri. 12 12 11 10 11 11 10 9 6 5 5 5 5 6 6 4 5 5 7 8 10 14 14 17 209
05/20/2017 Sat. 15 15 13 12 12 12 11 9 4 6 7 7 8 11 9 8 8 10 10 10 10 14 13 17 251
05/21/2017 Sun. 15 13 14 13 13 13 11 9 4 4 5 5 8 10 8 7 11 10 9 9 8 14 18 13 244
05/22/2017 Mon. 12 12 10 10 10 10 10 8 4 4 6 5 4 5 6 4 4 5 4 4 6 11 10 10 176
05/23/2017 Tue. 10 11 11 10 10 9 10 8 5 5 5 5 6 5 6 6 5 7 7 6 6 13 11 11 189
05/24/2017 Wed. 10 11 11 11 10 10 10 9 6 6 5 5 4 6 5 4 5 5 7 10 13 15 14 16 210
05/25/2017 Thu. 14 11 10 10 10 11 9 8 5 5 5 5 5 5 5 6 6 7 6 6 5 12 11 11 188
05/26/2017 Fri. 12 12 12 11 11 11 10 9 5 5 6 5 5 5 5 5 5 5 5 4 5 11 11 11 186
05/27/2017 Sat. 12 13 12 12 12 12 10 9 4 4 6 5 5 6 6 6 6 5 5 5 5 11 11 11 192
05/28/2017 Sun. 12 13 14 13 14 13 10 9 4 4 4 4 5 6 6 7 7 7 7 8 6 12 14 12 209
05/29/2017 Mon. 12 12 12 11 11 11 10 8 4 4 4 5 6 6 6 6 5 5 5 4 4 11 10 10 181
05/30/2017 Tue. 11 11 10 10 10 10 10 7 4 5 5 4 4 5 5 4 5 5 5 4 4 10 10 10 169
05/31/2017 Wed. 10 11 11 10 10 10 10 8 4 6 6 5 5 5 5 5 5 5 7 7 6 12 13 10 186
06/01/2017 Thu. 11 11 10 10 10 10 10 8 5 5 6 4 5 5 5 5 5 6 7 7 7 12 14 12 188
06/02/2017 Fri. 12 13 12 12 11 12 11 11 5 5 5 5 5 5 5 5 5 6 9 13 12 16 22 15 230
06/03/2017 Sat. 13 12 13 12 13 11 11 11 8 11 13 10 14 12 13 12 10 16 12 14 13 16 25 15 310
06/04/2017 Sun. 14 13 13 12 12 12 11 9 5 5 5 7 10 13 14 13 15 12 12 15 11 17 24 14 290
06/05/2017 Mon. 11 12 11 10 11 10 10 11 7 9 13 12 13 10 11 9 8 13 11 14 19 17 17 12 284
06/06/2017 Tue. 11 10 11 10 11 10 11 10 11 13 13 9 7 13 9 5 9 10 8 11 14 18 20 12 266
06/07/2017 Wed. 11 11 11 11 10 10 11 11 12 5 5 6 5 5 6 5 5 6 11 17 17 15 22 15 242
06/08/2017 Thu. 11 11 11 11 11 10 10 10 8 6 5 5 5 5 5 6 5 6 8 11 12 18 17 14 223
06/09/2017 Fri. 12 12 11 11 11 11 11 9 6 8 12 9 10 12 15 7 6 6 7 6 8 12 11 14 237
06/10/2017 Sat. 12 12 12 11 12 12 10 10 5 7 12 15 10 9 14 11 7 5 7 6 6 13 13 12 240
06/11/2017 Sun. 12 13 13 12 12 12 10 8 4 4 4 4 6 6 6 6 6 5 5 5 4 10 10 10 187
06/12/2017 Mon. 11 11 10 10 10 10 10 9 5 6 6 5 5 6 6 5 5 6 6 7 7 12 10 12 190
06/13/2017 Tue. 12 11 10 10 10 10 10 8 5 7 6 5 5 6 9 7 5 6 7 8 9 15 12 15 208
06/14/2017 Wed. 14 12 10 10 10 11 10 10 7 13 6 6 6 6 6 5 5 6 8 8 8 14 14 16 220
06/15/2017 Thu. 12 12 12 11 12 12 11 9 5 7 6 6 5 5 6 5 4 6 8 7 8 15 14 15 215
06/16/2017 Fri. 14 13 12 12 12 12 11 10 4 5 5 5 7 7 5 5 5 6 7 8 9 16 15 17 222
06/17/2017 Sat. 15 14 13 13 13 12 11 11 5 4 5 6 7 9 11 10 9 10 11 8 8 13 15 18 249
06/18/2017 Sun. 14 13 13 14 14 13 11 10 4 4 4 5 7 8 9 7 9 8 8 9 8 14 16 12 235
06/19/2017 Mon. 11 12 12 11 11 11 11 11 5 6 6 5 5 6 6 5 5 6 6 5 4 12 12 11 196
06/20/2017 Tue. 12 12 12 11 12 11 11 9 5 5 6 6 6 6 6 6 6 6 7 8 8 13 13 15 210
06/21/2017 Wed. 13 11 11 10 11 11 11 9 4 5 5 5 5 8 8 6 5 8 8 8 8 15 14 16 216
06/22/2017 Thu. 12 11 11 11 11 11 11 9 5 5 5 5 4 5 5 5 5 7 8 8 8 13 13 15 205
06/23/2017 Fri. 13 12 12 12 11 12 10 10 5 5 5 4 5 5 5 5 5 5 7 8 8 13 13 16 207
06/24/2017 Sat. 14 14 13 13 13 13 11 11 4 4 6 6 7 9 9 8 8 9 9 8 8 16 15 17 243
06/25/2017 Sun. 15 14 16 17 15 15 11 9 4 4 4 5 7 8 10 8 10 9 8 6 5 12 11 13 236
06/26/2017 Mon. 11 11 11 11 11 11 11 9 5 5 5 5 5 5 5 5 5 5 5 4 5 11 11 11 183
06/27/2017 Tue. 11 11 11 11 11 11 11 9 5 5 6 5 6 5 5 5 6 5 5 4 4 11 11 11 186
06/28/2017 Wed. 11 11 11 11 11 11 10 9 5 5 6 6 5 6 5 6 5 5 6 4 5 11 11 11 189
06/29/2017 Thu. 11 11 11 11 11 11 11 10 4 5 5 4 4 5 5 5 5 6 6 5 4 11 11 11 183
06/30/2017 Fri. 12 13 12 12 12 12 11 9 5 5 5 5 5 5 5 5 6 5 5 6 5 11 12 13 195
07/01/2017 Sat. 13 13 13 13 13 14 11 8 6 4 5 6 6 6 7 6 6 7 7 7 10 18 16 21 235
07/02/2017 Sun. 15 14 14 15 14 14 12 9 4 4 6 6 6 7 8 7 7 5 4 5 4 11 11 12 213
07/03/2017 Mon. 12 12 11 11 11 11 11 11 5 5 5 5 4 5 5 5 6 7 7 6 6 13 11 12 195
07/04/2017 Tue. 12 12 12 12 12 13 11 9 4 4 5 4 4 4 4 4 4 4 5 4 4 10 11 12 181
07/05/2017 Wed. 12 12 12 11 11 11 11 8 5 5 5 4 5 5 5 5 6 7 7 6 6 12 13 11 195
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City of Fort Lauderdale Performing Arts Center Authority (PACA) Garage
 Energy Consumption Rate: Pre & Post LED Lighting Upgrade

 Beginning January 23, 2017 - July 5, 2017 

24-hour  Energy Consumption (Unit: kWh)

City of Fort Lauderdale Performing Arts Center Authority (PACA) Garage
Energy Consumption Rate: Pre & Post LED Lighting Upgrade

Beginning January 23, 2017 - July 5, 2017

Location max/min temperature data is from NOAA’s climate data online resource https://www.ncdc.noaa.gov/cdo-web/
Energy data is from FPL https://www.fpl.com/

Figure 6

https://www.ncdc.noaa.gov/cdo-web/search
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5)	 For more specific information, click the name of the city, a table 
named Daily Summaries Location Details will appear. The table has 
a row entitled Included Stations—within that row you can click See 
station list below in order to select specific weather stations by using 
the ADD button. This will produce the most specific temperature and 
precipitation data based on facility locations. 

o	 To determine the location, data sets (e.g., temperature, 
precipitation, both), and date ranges of the data set, click on 
the station name in the STATION NAME & ID column. 

6)	 Within the Cart a list of options for the output format will appear. 
In order to open the data in an Excel file, select the Custom GHCN-
Daily CSV and verify the dates in the Select the Date Range box. Click 
CONTINUE.

7)	 On the next page, under Station Detail & Data Flag Options include 
the Geographic Location in addition to the Station Name in order to 
receive the weather station coordinates. 

8)	 Select the desired data types in the Select data types for custom 
output box (e.g., Precipitation, Average Temperature, Minimum 
temperature, and Maximum temperature). Click CONTINUE. 

9)	 Specify and email address in the Enter email address box and SUBMIT 
ORDER to have the data emailed to the specified email account. 

10)	Once the email arrives, click Download.  Note: if multiple requests are 
submitted at once (i.e., single cart), the data will be combined into a 
single spreadsheet.

11)	Align the dates between this spreadsheet and the heat map and 
copy and paste the weather data. Note: some dates may be missing 
information and some dates may be missing.

12)	 In order to easily view temperature and energy usage, conditional 
format the desired temperature columns as Red-White-Blue to create 
a scale with blue being the coldest and red being the hottest.  
(Figure 7)

13)	Align weather data with energy consumption data by date and paste into the heat map. 

For More Information, Contact:

Sustainability Division, Department of Public Works
City of Fort Lauderdale
sustainability@fortlauderdale.gov
954.828.6190

Figure 7

mailto:sustainability@fortlauderdale.gov

